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. No.1 weekly digital

If you're already a
reader, thanks for your continued

support and involvement; if you're
new to Photography Week, you've
come to the right place! In addition

to expert advice, brilliant tips and

step-by-step tutorials, every issue

features interactive galleries of
brilliant photos, how-to videos on

Welcome to the world's

photography magazine.

essential shooting and editing
techniques, and in-depth reviews
of the latest camera Kit.

But that's not the whole story.
Photography Week is more than
a magazine - it's a community
of like-minded people who are
passionate about photography.
To get involved, just follow any
of the links below and share your
shots and comments.

Jeff Meyer, Editor

JOIN THE PHOTOGRAPHY WEEK
COMMUNITY AND START SHARING!

QOO

F/-\CEBOOK TWITTER FLICKR

http://bit.ly/39py9lg nttp://bit.ly/2vGadLP http://bit.ly/2VIgs]0

We're more than just a magazine - read on and discover the many
ways you can interact with and enjoy Photography Week
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It plugs a gap in Panasonic's
L-Mount lineup, and it's
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light — but does that mean
compromises on handling
and image quality? Find out
in our in-depth review
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WHAT' S HOT

THE WEEK'S TOP HEADLINES IN PHOTOGRAPHY

THESE COMPACT LIGHT METERS
FIT ON YOUR CAMERA HOTSHOE

They're stylish, feature-packed and easy to use, and will fit almost any camera

apix, a UK brand that markets

C film processing and scanning
equipment, has launched a
pair of new, compact, and innovative
hotshoe-mounted light meters, the
KEKS KMo02 OLED and KM-Q.

The KEKS KMo2 (pictured above) is
the more advanced of these two new
light meters. It has a metering cell at the
front and an OLED exposure display at
the back, with customisable options for
shutter speed, lens aperture and ISO
settings, together with the ability to shift
exposure compensation from -3EV to

+3EV. It's powered by an internal battery
offering 21 hours of continuous use, and
you can create presets for up to three
camera and lens combinations.

We don't have any more detailed
specifications at the moment, except
that it offers continuous and single
metering modes and a VEML7700 “high
accuracy ambient light 16-bit digital
resolution sensor”.

The continuous and single metering
modes look interesting because you can
take a fixed one-click exposure reading,
or move the camera around to see how

the exposure changes with framing and
pointing at different areas of the scene.

It doesn't rely on any electrical
connections with the camera, so you
should be able to attach it to pretty
much any camera maker or model with
a hotshoe - or on a coldshoe, for that
matter. It's available now, and costs
£139 / $112.

The KM-Q is smaller - about the
size of a sugar cube - and has fewer
features, but it also has the metering cell
on the front and an OLED panel on the
back. It costs £119 / $85.

© Capix



PRO
CHRIS GRIMMER
CAMERA:
CANON EOS 6D,
7D & 70D
Chris was shortlisted for
the Insight Astronomy
Photographer of the Year
in 2016, and he's also
been shortlisted for the
UK Astrophotographer
of the Year - so it's safe
to say he knows a thing
or two about capturing
great shots of starry
skies. Chris uses a whole
host of equipment, from
converted EOS cameras
to tripod heads that rotate
to track stars. You can
see his work at
ns:// bit.ly/3M2SBe8
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SHOOT FOR
THE STARS

Astrophotography pro Chris Grimmer
shows an enthusiast with just a couple
of years of taking photos under his
belt how to capture amazing
images of the night sky

APPRENTICE
STEVE DYTHAM
CAMERA:
CANON EOS R6
Steve took up
photography as a hobby
over the Covid lockdowns
in 2020 and 2021. He's
based in Peterborough,
UK, and is often out with
his camera shooting
wildlife at some of his
favourite local nature
spots. While he has a
passion for nature, he also
wants to learn how to take
better landscapes and
night shots, so we paired
him with astro pro Chris to
show him the ropes at a
suitably dramatic ruined
church near King's Lynn
in Norfolk.
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TECHNIQUE ASSESSMENT PRO TIP

SHOOT RAW+]PEG

Chris showed Steve how to use the
Raw files are larger than JPEGs and capture much more tonal
Manual mOde tO take fuu- ContrOl information, which is very handy when shooting in low light. However,

Chris also likes to have JPEG images to work with, as these smaller
files can be more manageable when loading a big batch of star trail
photos into software such as the free Startrails program. A good idea
is to use a high-capacity memory card, and shoot both raw+JPEG so
that you have both file types for editing if needed.

STARTING SETTINGS

Chris suggested that Steve start out in Manual mode so that he could
take total control over his exposures. Chris recommended starting with

a shutter speed of 30 secs for pin-sharp stars when using his equatorial
mount. He also suggested that Steve increase his ISO to 3200 to make the
sensor much more sensitive to light, and open the aperture on his lens as P RO TI P

wide as it could go to suck in as much light as possible.
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MAN UAI_ Fo c USI N G To support the weight of equatorial mounts and heavy telephoto

Focusing at night can be tricky, and Chris explained that you have two lenses, Chris uses a Charles 2.0 pro tripod from Three Legged
options: focus on the foreground, or focus on the stars, depending on which Thing - its magnesium alloy construction can handle loads of up
you'd prefer to be sharp. To focus on the foreground he shone a bright to a whopping 40kg. He also uses a 3LT Airhed Pro ball head for
torch on the church so that Steve's camera could lock autofocus, and then fast adjustments, which can be mounted directly to the tripod or
switched to MF to lock it off. He also showed Steve how to focus on the equatorial mount. The ball head has an Arca-Swiss mount that works
stars by going into live view, and pressing the magnifying glass button to with his L-bracket, so he can quickly switch between portrait- and
zoom in so that he could see the stars clearly enough to manually focus on landscape-orientation shooting.

them until they were sharp pin-pricks of light.

EXPERT INSIGHT
CHECK THE WEATHER

Crisp winter nights free from clouds are perfect for astro shoots,

so check as close to your chosen night as possible for the most

accurate forecast. In the UK, sites likemetoffice.gov.uk|and[bbc
co.uk/weather will give you a good indication of cloud cover in the

area you wish to shoot. An app like Clear Outside is even better, as it
shows you the low, medium and high cloud coverage in more detail.



http://metoffice.gov.uk
http://bbc.co.uk/weather
http://bbc.co.uk/weather

CHRIS'S COMMENT

| met up with Steve a few hours after
sunset at Wiggenhall St Peter Church,
south of King's Lynn. Now a ruin, the
churchis a striking bare-bones skeletal
structure without a roof or rafters, so you
get an amazing view of the night sky
behind and above. | suggested composing
with a wide-angle lens to include lots of
the church in the foreground, and using
the stone arch to frame the tower, the stars
and Milky Way. | used an equatorial mount,
which tracks the stars at the same rate as
the Earth's rotation.

LENS 14mm /2.8
EXPOSURE 30 secs, /2.8, 1SO3200
(seven images stacked)

EXPERT INSIGHT
LCD BRIGHTNESS

The bright glare from your camera’s
LCD screen will reduce your night
vision, which will make it harder to see
in the dark and compose. There is a
handy solution though: simply go into
your camera’s menu and lower the LCD
brightness to its minimum setting. Just
remember to turn it back up to a middle
value when you're back out shooting in
the daytime.
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EXPERT INSIGHT
GET TO KNOW YOUR MOON PHASES

An important aspect of astro photography is the moon's phase in

the lunar calendar. We all know that on a full moon the moon is at its
brightest, and while this can be an interesting way to light a landscape
at night it's not ideal for astro, as you need the sky to be as dark

as possible for stars to be vivid and clear. Shooting around a 'new
moon'is ideal. It's also worth checking the moonrise and moonset
times: shooting when the moon is below the horizon will help to cut
down light pollution and boost contrast. The Moon Phase 2024 Lunar
Calendar featured on www.timanddate.com is a great resource.

'LENS VA28, i e
EXPOSURE 30 secs, f/2.8, ISO329

(seven |mages stacked)

PRO TIP
PAINTING WITH LIGHT

Shooting in low ambient light levels
at night can make your foreground
look very dark. While a silhouetted
structure can look very effective, it's also
worth carrying a powerful hand torch

(or flashgun) that you can use to light
up the foreground to reveal detail. Chris
uses a small hand torch to evenly paint

over architecture at night to stop it being
in silhouette. He explained: “Painting
with light is a handy trick to reveal

detail in your focal point, but I'd refrain
from shining bright lights in designated
astronomy locations out of respect for
other photographers and astronomers,
as it could spoil their images.”

STEVE'S COMMENT

Next, we headed ‘outside’ to take some shots of the church exterior to add scale
and context. Once again using Chris's equatorial mount tripod head, we were able
to shoot long exposures to capture a really deep Milky Way. The church has a few

houses either side of it, so there was some light pollution, though | was surprised

with how much star detail we captured on Chris's astro-modified Canon EOS 6D,

and the light pollution has actually helped to light the church a little bit here. We

took six shots of the stars and stitched them together to build up the Milkky Way,
and a seventh shot to capture a sharp foreground.



http://www.timanddate.com
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LENS 18-55mm f/3.5-5.6
EXPOSURE 30 secs, f/3.5, 1ISO1600 (60 images stacked)

EXPERT INSIGHT
SHUTTER RELEASE CABLE

HOT SHOT #3

STEVE'S COMMENT

Chris explained that instead of shooting pin-
sharp stars, you can lean into the blur caused
by the Earth's rotation to shoot star trails. We
framed up on a tripod, without the need for an
equatorial mount. Chris pointed out Polaris (the
North Star) in the sky, and explained that all of
the stars will rotate around this point. We set the

A shutter release cable plugs into your camera body, and allows you to fire focus on the church and took a test shot at 30

the shutter remotely so that you don't risk introducing blur when you press secs, /3.5, 1SO1600. We then set the camera
the shutter button; it also means you don't need to enable the 2-sec self-timer to continuous drive mode, inserted a shutter
drive mode. They allow you to lock the shutter button down to fire continuous . .
exposures, and also set custom exposure times by using Bulb mode. More release cable, and locked it down so that it

advanced shutter releases have features like an intervalometer, which comes would fire 30-second exposures back to back.
in handy for shooting timelapses. For this image we left the camera running for
about an hour, merging a total of 60 exposures.
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LENS 100-500mm f/4.5-7.1

EXPOSURE 30 secs, f/5 6, |SO3200 (120 |mages stacked)

PRO TIP
TURN UP THE HEAT

Condensation will be
your biggest enemy when
shooting stars for long
periods on cold winter
nights. Moisture can find
its way onto the front

CHR'S‘S COMMENT li N element of your lens

| wanted to show Steve how to zoom closely into star | = when you're set up over
constellations and interesting nebulae for mesmerising g SHITES (ol Gi2efp-ehy
. or star trail images, and
deep-sky photos. Steye had h|leanon RF 100-500mm : , this can make details look
F4.5-7.1L 1S USM lens with him, which was perfect - we only : 7 blurry. To prevent this,
needed to zoom into about 300mm on his full-frame Canon > \ Chris uses a lens heat
EOS R6 to fill the frame with this gorgeous North American wrap which he bought
Nebula. When choosing which nebula or galaxy to focus on enline jer Less nar 220
're at the mercy of what is ‘up’ in the sky at the time of and which is powered
youre a y . P y by USB power bank to
year: the North American Nebula was a good target for us ’ ~ 4 ensure lenses stay warm
to set our sights on and shoot continuously for an hour - the . and condensation-free.

more images you take, the better.
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LENS 14mm f/2.8 IF ED UMC
EXPOSURE 10 secs, /2.8, 1ISO3200

STEVE'S COMMENT

For this shot we headed ‘inside’, and
Chris suggested using his Samyang
14mm wide-angle lens to squeeze
in more of the interior architecture,
allowing room for the stars and
Milky Way above too. With Chris's
help we composed looking up at

this tower, which | was able to focus

on when Chris shone his head torch

on it, giving me enough light to lock
the autofocus. It was then a case

of shooting in Manual mode with a

wide aperture, high ISO sensitivity

and a shutter speed of 10 secs - as
without the equatorial mount longer
exposures would turn the stars into
trails rather than pin-points of light.

CHRIS'S VERDICT

It was fantastic sharing my passion
for the stars with Steve, and he
dived head first into this brand-new
frontier. As with any architectural
shot, it's important to get the right
perspective so that straight lines
look straight, and we also wanted
this image of the tower to be
symmetrical, so we moved around
until the camera and tripod were
in the centre of the church. I also
nudged some of the architectural
lines into place to make them
look straight in Photoshop, and
boosted the contrast of the Milky
Way above the tower to make it
more prominent. | hope I've shown
Steve a new location to practise his
astrophotography, and also proved
that, with the right know-how, you
don't need to be in a totally dark-
sky area to take top astro shots.
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CHRIS'S TOP 10 TIPS FOR
SUPERB STAR SHOTS

BULB MODE

While he primarily shoots in
Manual mode, Chris is often limited to
maximum shutter speeds of 30 secs.
When he needs to shoot for longer
he'll use Bulb mode.

TURN THE SELF-TIMER OFF

Any delay between shots when
shooting star trails will appear as
gaps in between the trails, so switch
the self-timer off, and use a remote
release cable.

AVOID LIGHT POLLUTION

It's best to travel as far as you can
from the bright glow of city lights, as
these can limit how ‘dark’ the sky is.
Visit www.darkskydiscovery.org.uk to
find a dark-sky zone near to you.

IN-CAMERA NOISE REDUCTION
With low light levels and high ISO
values, digital noise can be a problem.
Many cameras have a Long Exposure

Noise Reduction feature, which can

be applied to exposures longer than

1 sec. This method requires a second
‘blank’ exposure to be taken, so it's not
suitable for star-trail sequences.

USE THE ‘500" RULE

This rule helps you work out the
exposure needed to take pin-sharp
star shots by dividing 500 by your focal
length - so, for example, at 20mm
your exposure can be no longer than
25 secs. With modern high-resolution
cameras it's worth being conservative
and reducing the exposure length even
more to ensure sharp stars.

BUDDY UP!

When venturing out at night with
your expensive camera kit be sure to
team up with a photographer friend to
stay safe and have fun together.

LOOK OUT FOR CELESTIAL EVENTS
The night sky is ever-changing, and

from lunar eclipses to meteor showers,
and comets whizzing past to solar
flares, resources like the BBC Sky at
Night Magazine can help you plan
shoots throughout the year.

POWER UP!

Cold nights and shooting for long
periods will drain your batteries, so
make sure you charge up, and also
take plenty of spares.

STOP YOUR LENSES FOGGING

Condensation forms when you bring
a cold lens into a warm home. Wipe off
moisture with a microfibre towel, then
leave the lens in your kit bag in a cold
room so that it can acclimatise slowly.

1 BRING A BACKUP CAMERA

Bring a spare camera and tripod
so that you can work on alternative
angles to keep you busy while your
main camera is recording deep-sky
or star-trail shots.



http://www.darkskydiscovery.org.uk
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ESSENTIAL GEAR

The kit Chris relies on for capturing top night sky shots
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@ EQUATORIAL MOUNT

Long exposures tend to pick up the Earth'’s rotation
and turn the stars from pin-points of light into trails, and this
means Chris needs to track the stars at the same speed as
the Earth'’s rotation. He uses a battery-powered Sky-Watcher
Star Adventurer Pro equatorial mount on his Three Legged
Thing Charles 2.0 tripod, which is lined up with Polaris, also
know as the North Star.

MODIFIED CAMERA BODIES

Chris owns a standard Canon EOS 7D and two
modified bodies - an EOS 70D and full-frame EOS 6D. He's
modified the DSLRs by removing the internal IR and UV
filter, which allows more red spectrum to be recorded and
optimises them for astrophotography. On his 70D he's also
added a Skytech Quad band filter, which lets in hydrogen,
oxygen, nitrogen and hydrogen beta wavelengths to capture
more detail.

WIDE-ANGLE LENSES

50mm is considered to be a ‘standard’ focal length on
a full-frame body as it has roughly the same angle of view as
the human eye, so images have a natural look to them. A lens
with a focal length wider than 50mm is considered to be a
‘wide-angle', with a much wider perspective, which is perfect

for squeezing in loads of starry details above your night
scenes. Chris uses a Samyang 14mm f/2.8 IF ED UMC on his
full-frame EOS 6D and a Canon EF-S 10-18mm f/4.5-5.6 IS
STM on his Canon APS-C DSLRs when he needs to go wide.

TELEPHOTO LENS

A telephoto lens has a focal length longer than the
‘standard’ 50mm, and will bring distant details into view. Steve
has a passion for wildlife photography, and had his telephoto
Canon RF 100-500mm F4.5-7.1L IS USM to hand, which was
perfect for the task. You may be surprised to learn you don't
need a super-long focal length to fill the frame with distant
nebulae or galaxies - 300mm is usually powerful enough on
a full-frame body. Chris's go-to telephoto is a William Optics
RedCat 51, which has a focal length of 180mm, or 288mm on
his APS-C Canons due to the 1.6x crop factor.

GOOD HEAD TORCH

A head torch is a must for astrophotographers, as
it'll help you stay safe and see where you're walking, and
it also frees up your hands to compose and operate your
camera. Make sure you get a head torch with a red filter,
as bright white LEDs are a surefire way to reduce your night
vision - and annoy any fellow astrophotographers that may
be taking shots!
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PRO TIP
EDITING SOFTWARE

To merge a series of exposures to create a star trail image, start
by loading all of your files into Photoshop as layers from Adobe
Bridge via Tools > Photoshop > Load files in Photoshop Layers,
then in the Layers panel change the blending mode of all of
the layers to Lighten. Alternatively, Chris uses the free Startrails
software for Windows, which you can use to create star trail
images and timelapse movies.

CHRIS'S FAR-OUT STARS & GALAXIES

EXPERT INSIGHT
ASTRO APPS

Chris uses a whole host of apps on his phone to help him take
astro images - he's created a folder on his phone to keep them

all organised. His two favourite apps are Stellarium Mobile Star
Map (free for iOS and Android but with in-app purchases), which
locates the Milky Way. He also uses PhotoPills (£10.99 iOS / £10.99
Android), which is useful for night shots too.

Professional astronomy photographer Chris reveals his three favourite astro images

-

T

BUBBLE AND LOBSTER CLAW This nebula was one of the first that | photographed,
SO seven years on | wanted to revisit it and do it justice. This is a two-panel mosaic looking
at hydrogen and oxygen emissions.

JELLYFISH NEBULA This is another revisit,

of a subject that | first captured back in

DUNWICH MILKYWAY Dunwich is one of the darkest locations I've visited, and | shoot there 2017. Better kit and six years of experience
regularly. This is a multi-panel mosaic using a standard DSLR and sturdy tripod. resulted in a very different nebula image.




SUBSCRIBE TODAY AND ENJOY
PHOTOGRAPHY WEEK FOR
JUST 39¢/39r AN ISSUFE

THE WORLD®S BEST-SELLING DIGITAL PHOTO MAGAZ

Pwhggography

INSPIRATION| IDEAS | IN-DEPTH REVIEWS

SHOOT FOR
THE STARS ===

PRO TECHNIQUES AND TIPS FOR CATURING
INCREDIBLE IMAGES OF THE NIGHT SKY

N —

To find out how you can get Photography Week delivered straight
to your device every week for just a few pennies, simply search
for Photography Week on any of the platforms below

AVAILABLE ON YOUR DEVICE NOW!

# Download on the ‘ - . ™
@& AppStore @F)OCKEU'I'\E}QS ‘ Z1nio
https://apple.co/2Rjol0d http://bit.ly/2txbB2B http://bit.ly/36k07T(

*Available for a limited time only. Standard subscription offer varies across platforms/devices - please refer to specific store for the most up-to-date offer


http://bit.ly/2txbB2B
https://apple.co/2RjoI0a
http://bit.ly/36kQ7TC

0000600
XPOSURE

THE WEEK'S MOST INSPIRING READER PHOTOS

CURVED LINES TO THE BIG MOUNTAIN
MARIO OTTAVIANI
“This is the typical ‘lunar’ landscape in the heart of Italy’s Abruzzo region. The
mountain in the distance is the ‘Gran Sasso’, the highest of the Italian Apennines.”

https://bit.ly/3Akm016


https://bit.ly/3Akm016

THE WEEK'S MOST INSPIRING READER PHOTOS

THE TUNNEL
MARK GREENFIELD
“I took this photo early in the morning, in an attempt to avoid being
run over by cyclists in this bike tunnel near Rotterdam central station.”

https://bit.ly/3vIBExW


https://bit.ly/3v1BExW

THE WEEK'S MOST INSPIRING READER PHOTOS

PRINCESS ZELDA
SALVATORE VITALE
“I took this photo at the 2023 Lucca Comics & Games fair in Tuscany.
The model photographed is dressed as the character Princess Zelda
from the video game The Legend of Zelda: Tears of the Kingdom.”

https://bit.ly/3zmSjel
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BENCH
JEAN-YVES BESSELIEVRE
“The transition from sunset to the blue hour. Taken with my iPhone 13 Pro Max."

https://bit.ly/3NIHONS

PHOTOGRAPHY WEEK WANTS YOUR PHOTOS!

Taken a portrait you're particularly proud of? Shot a sensational sunset you'd like to
show off? Then join the Photography Week Facebook community and share your best
photos today! You'll get feedback from fellow readers and the Photography Week
team, plus the chance to appear in Xposure, or even on our cover!
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TS COOL, THAT

THE BEST THING WE'VE SEEN THIS WEEK
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lan Ford, Winner, Natural World & Wildlife

Ana Skobe, Winner, Architecture

PORTRAITS AND PREDATORS:
WPA ANNOUNCES OPEN WINNERS

Prestigious contest reveals its latest round of amazing winning images

he World Photography Organisation
6 has announced the category

winners and shortlisted images in
the Open competition of the 2024 Sony
World Photography Awards, showcasing a
stunning and diverse collection of images
from photographers around the world.

Winners were announced in 10

categories, including Travel. Landscape,
Portraiture, and Natural World & Wildlife.
The awards include several competitions,

Michelle Sank, Winner, Portraiture

and the winners of the Youth, Student,
National and Regional contests have already
been announced. The overall winner of the
Open competition, along with the other
overall winners, will be announced at the
awards ceremony in London on April 18.

A selection of images will be featured in

SEE MORE TMAGES
https://bit.ly/3Vf0OgNO

the Awards exhibition, which is at Somerset e s
House in London from April 19 to May 6,

before going on tour. Click the link to see
more images at the competition website.

Images © The photographer and courtesy Sony World Photography Awards
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CRASH COURSE

ESSENTIAL PHOTO SKILLS MADE EASY

FLASH FUNGI

Master macro with off-camera flash to capture
mushroom photos with James Paterson

rom antibiotics to alcoholic
drinks, and from organic
decay to delicious food, fungi
play an important role in all
manner of things. They range in size
from tiny microscopic structures to the
largest living organisms on the planet.
Underground, the ‘wood-wide web' of
fine tendrils creates a network that
connects plants and trees. Above
ground, the fruiting bodies form as
mushrooms and other stunning
structures that offer some wonderful
opportunities for macro photography.
Fungi - and mushrooms in particular

- tend to prefer dark conditions like
dense woodlands, crevices in rotten
wood and shady areas. When you're
photographing in these murky spots,
a burst of flash can provide a welcome
lift to the scene. But it's not just about
increasing the light levels - a flash also
gives you the opportunity to enhance
the mood. By firing the flash off-camera,
either from the side, above, behind or
even below, we can highlight the fine
fungi features, draw attention to colours
and textures, or show the delicate gills
on the underside.

Whenever we add our own light into a

scene like this, the ambient daylight
becomes almost like a secondary light
source. We can decide whether the
daylight plays a major or minor role

in the exposure, either by balancing
our flash with it for a subtle lift, or by
overpowering it for a spotlight effect.

But before you head out in search of
fantastic fungi, it's worth saying that you
shouldn't touch anything you don't know.
Do not inhale spores, and be sure to
wash your hands. As for eating foraged
mushrooms, please heed the wise words
of Terry Pratchett: "All fungi are edible.
Some fungi are only edible once”

bib




HOW TO SHOOT MAJESTIC MUSHROOMS

Get your off-camera flash set up for fungi close-ups

EXPOSURE &
& APERTURE

Set the camera to Manual mode with

a 1/30 sec shutter speed at f/8 and
1ISO100. A mid-range aperture like this
will give you the sharpest results; lenses
tend to perform their best a couple of
stops down from the maximum aperture.
Even at f/8, the depth of field will be very
limited, so precise focusing is crucial.

O FLASH TRIGGERS

Key to this technique is learning how to
fire your flash off-camera. You'll need

a wireless trigger and receiver for

this (we used a set of Godox triggers).
With tiny macro subjects the slightest
change to the position and angle of
the flash can have a huge impact, so
experiment with your flash placement.

TRIPOD AND
o FOCUSING

Atripod is a must for macro
photography, not just because it lets
you slow your shutter speed, but also
because it means you can be really
precise with your focusing. Manual focus
is best. Use Live View and zoom in, then
use the focus ring to ensure the front
edge of the mushroom is sharp.

T e L T

© smaLL SoFTBOX

A small portable Lastolite softbox is
fitted over the flashgun. This diffuses
the harsh light from the flash bulb so
that it looks softer and more natural.
The softbox is angled so that the
edge of it catches the subject, rather
than directed straight at it - this
feathers the light to give it more of

a wraparound quality.

€ SPEEDLIGHT

Fired at 1/4 manual power, the
flashgun is placed slightly behind
the subject and angled back towards
the camera so that it doesn't spill
onto the area beyond the subject.
This helps the backdrop to come out
nice and dark, which, in turn, helps
the water drops to stand out.

@ \ATER SPRAYER

Water spray can add extra atmosphere
to your macro photography, especially
if you're using flash. The flash will
freeze the droplets and make them
sparkle and glow. Try spraying water
over the mushroom and capture drops
falling off the bonnet. If your camera

is on a tripod, combine several frames
with the best droplets.
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TOP TIPS FOR FUNGI PICS

CONTROL THE FLASH

Setting the right flash power can be a matter
of trial and error. Begin by working out a manual
exposure without the flash. Set an aperture f/8
and 1ISO100, and adjust the shutter speed until
things look dark. Now turn on the flash and use

it to lift the subject - here the flash is at 1/16

manual power.

BRING A BEANBAG

You'll often need to be shooting low to

the ground to capture mushrooms and fungi.

As such, a small beanbag like this comes in
very handy to prop up your camera. A flip-out
screen is also hugely useful for shooting at low

angles, and waterproof trousers will come in

handy when you're kneeling down on damp

ground for close-in shots.

3

CREATE DEPTH

For a sense of depth and to blur out the
background, find an angle with empty space.
Shooting down the length of the fallen tree
gives us space beyond the common bonnet
mushrooms. If we shot straight on, it would be
difficult to get the flash to the side and darken
the backdrop.



TOP TIPS FOR FUNGI PICS

1/40 SEC 1/20 SEC . 0

AMBIENT EXPOSURE

Your shutter speed has no influence on the
flash, only on the ambient light. Here, the left
side was shot at 1/40 sec, the right at 1/20
sec. The subject stays similarly lit, but the light
behind it changes. For a brighter or darker
backdrop with flash, tweak your shutter speed.

DRESS THE SCENE

When shooting close-ups the tiniest
distractions really stand out, so take the time
to tidy any messy details, like stray strands of
grass or flecks of mud. You might also want to
‘dress’ the scene - here, for instance, the red
berries were scattered around the black earth

tongue fungi to add a splash of colour.

FINDING FUNGI

Fungi grows year round in all kinds of
conditions, and it's amazing how many you can
find once you start looking. Most prefer dark,
damp conditions, although some like open
spaces, like fields. Check decaying wood and
inspect the forest floor. This yellow spindle coral
fungi can be found in mossy lawns.




HOW TO FOCUS STACK YOUR FUNGI PHOTOS

Shoot a set of images for a focus stack, then merge them
in Photoshop for front-to-back sharpness

@ sHooT FOR A STACK @ ALIGN THE LAYERS € BLEND THE LAYERS

To get macro subjects sharp you could You can use Photoshop to automatically  In the Auto-Align settings choose

try shooting for a focus stack. Focus combine the sharp parts into a single Auto and hit OK. Ensure the layers are
on the closest point and take a shot, image. Go to File > Scripts > Load Files highlighted then go to Edit > Auto-Blend
then shift the focus point backwards into Stack and load in your set of images.  Layers. Set ‘Stack Images’ and hit OK
and take another, Continue until you've Once done, go to the Layers panel, Grab the Crop Tool and crop off the
captured sharpness across the subject. highlight the top layer, then hold Shift messy edges. Make any tonal changes
Some cameras have a focus shift mode  and click on the bottom layer to select you like, then sharpen the image to finish
that can shoot the stack for you. them all. Go to Edit > Auto-Align Layers. off with Filter > Sharpen > Unsharp Mask.

PUFF PIECE

Create a spotlight effect with a flash
to capture the wonderful wolf fart

A flash is a brilliant tool for nature
close-ups. Here, for instance, by picking
out the subject with the flash we can
create a spotlight effect and allow the
backdrop to become moody and dark.
To do so, we set a manual exposure that
underexposes the natural light (1/100
sec, /8, 1S0O100), then turned on our
flash and used it to lift the foreground.
This is the ideal setup to show the

puff of spores emitting from this little
stump puffball - the puff wouldn't
stand out without the flash to darken
the background and light the spores.
Spores are usually
released by raindrops,
but a gentle poke
doesn't do the puffball
any harm (take care, as
inhaling large quantities
can be dangerous). The
scientific name for this
family of mushrooms

is Lycoperdon, which,
rather wonderfully,
translates as ‘wolf fart'!
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AFFINITY PHOTO

LEARN ESSENTIAL EDITING SKILLS FAST!

HOW TO...

GET THE LONG-EXPOSURE LOOK (@

James Paterson shows you how to use the Stack feature in
Affinity Photo to combine a set of photos and blur choppy waters

ew photography effects can

beat the look of a long exposure,

especially the beautiful motion
blur you get when shooting moving
water with a slow shutter speed. During
daylight hours the slow shutter speeds
you need can usually only be achieved
with the use of a neutral density filter,
which slows the flow of light into your
camera. But sometimes you can be
caught short without a neutral density
filter, and the water comes out looking
too choppy and detailed. If so, there's

another option. Using a tripod, you can
shoot a series of frames of the moving
water in quick succession and then
blend the images together in Affinity
Photo, and we'll show you how it's done
in this issue's video tutorial.

It helps if the frames you intend to use
are shot at your slowest possible shutter
speed. Ours were taken at f/16 and
1SO100, allowing us to achieve a shutter
speed of half a second at sunset. Using a
tripod, we captured a set of half-second
frames. That's long enough to create a

WATCH THE VIDEO
https://bit.lv/3V2C3vc

NLOAD THE
JECT FILES

W
0
https://bit.ly/3v0ITec

ON APCOR MAC

touch of blur in the waves, but nowhere
near long enough to get the misty water
effect you really only see with exposures
upwards of 30 seconds.

We'll begin here by using the Stack
feature to blend our frames with a neat
trick that averages out the motion in each,
then combine two blending methods
before adding filters to enhance the blur.
Finally, we can bring in parts from our
original images to complete the effect.
It's not quite as good as real in-camera
motion blur, but it's the next best thing.


https://bit.ly/3v0JTec
https://bit.ly/3V2C3vc
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LENS TEST

NION ON THE LATEST KIT

LUMIX S 100MM
F/2.8 MACRO

It ticks many boxes, but it's not a total success

anasonic cameras go from
e strength to strength, and it was

the fastest-growing full-frame
camera brand in 2023. However, The
company's Lumix S L-Mount lineup
still lags a little way behind the
competition, with one major omission
being the lack of a standard macro
lens. The L-Mount Alliance has in the
past saved the day for Panasonic
shooters, with fellow members Leica
and Sigma filling the gap with some
superb choices, including the Sigma
105mm /2.8 DG DN Macro, while
Venus Optics and TTArtisan offer
more affordable options.

Key features
But what is a camera system without
good first-party lenses? Finally

lwww.panasonic.com| £999/5999

Panasonic has seen fit to plug this
non-macro-sized hole with the new
Lumix S 100mm f/2.8 Macro; although
with Panasonic having a reputation of
notching up ‘firsts’ with its Lumix
cameras, this, not surprisingly, isn't
your typical macro lens.

Instead, Panasonic hopes to
set a new bar for macro lenses
everywhere with the world's smallest
and lightest full-frame autofocus
macro lens over gomm with 1:1
magnification. The lens also has the
world’s closest focusing distance for
a macro lens of the same description.
That's a lot of caveats to being a
‘world first’, but Panasonic's reduction
in size here is genuinely impressive.

Panasonic has achieved this size
reduction with a newly developed

1 Image quality isn't as sharp as you'd expect
from a lens of this class.

2 There's a noticeable lack of switches and

buttons on the lens.

3 A new Dual Phase Linear Motor has aided
the reduction in size.

Dual Phase Linear Motor (the motor
used for focusing), which Panasonic
claims offers the same performance
at a fraction of the size. Eagle-eyed
readers will spot fewer elements
than rivals and no optical image
stabilisation (OIS) as factors that
have also most likely contributed

to a much smaller body. But has


http://www.panasonic.com

LENS TEST LUMIX S 100MM F/2.8 MACRO
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We encountered occasional struggles with close focusing, with the lens hunting for focus before eventually locking on. However, this could be in part down to
the camera, and it's something that could be improved with a firmware update in the future

this size reduction also reduced the
performance? Let's find out.

Build and handling

There's nothing else to do but give a
round of applause to Panasonic'’s lens
design team - for a standard-length
1:1 macro lens designed for full-frame
cameras, it has really achieved
something special with this lens.

At only 82mm in length and 300g in

We have to applaud Panasonic’s lens design
team for achieving something special here

weight, there's no comparison with
the equivalent Canon 100mm, Nikon
105mm or Sony gomm - with those
lenses being 3859, 3309 and 3029
heavier respectively, and 66mm,
58mm and 48.5mm longer.

One undeniable benefit of
Panasonic's Lumix S prime lens
lineup is that each lens is designed
to be the same length and have the
same filter thread, which is a huge
benefit to anyone balancing a camera
for video on a stabiliser or gimbal.
Weight is also remarkably consistent,
with the lineup - from the 18mm all
the way to the 100mm lenses - only
differing in weight by 60g between
the lightest (35mm at 2959) and the
heaviest (85mm at 355Q).

With Panasonic being the hybrid
video camera brand to beat at
present, it's great to see video-first
design running through everything
Panasonic puts out. Seeing its
design foresight come to pass like

this gives me confidence in Lumix
going forward.

The lens follows the exact same
design language as the rest of
Panasonic's Lumix S lenses. Panasonic
lenses are generally good, although |
don't find them as premium-looking
or feeling as those of other brands.
The lens is made out of solid plastic,
and features a rubberised manual
focus ring that's easy to find and grip
without taking your eye away from the
viewfinder. The lens is weather-sealed
and freeze-resistant, so can resist the
elements when shooting outdoors,
although that should be expected on
a lens at this price.

The focus ring offers a good
amount of resistance and avoids
being overly sensitive, which is
essential for precise macro focusing.
There's a noticeable lack of switches
and buttons on the lens, although
with no OIS in the Lumix S 100mm,
perhaps there isn't much need for



LENS TEST LUMIX S 100MM F/2.8 MACRO

Shooting wide open in challenging light
situations, a few contrast issues were evident
in JPEG files, with out-of-focus areas looking
a little lacklustre

more switches. But with other brands
adding more custom function buttons
to their lenses, it's a shame not to see
at least one here.

Performance
Image quality is very good, but sadly
not as sharp as | would have hoped
for from a lens of this class and given
Panasonic's usual quality. Images look
a little soft at wider apertures, only
becoming clinically sharp when you
stop down to around f/8. That's not
uncommon, but it does lag behind
rivals if peak sharpness is your
number one priority.

Occasionally, when | was shooting
wide open in challenging lighting

00606

MOUNT: L-MOUNT FULL-FRAME: YES
CONSTRUCTION: 13 ELEMENTS IN 11
GROUPS ANGLE OF VIEW: 24° AUTOFOCUS:
YES MAX APERTURE: F/2.8 MIN
APERTURE: F/22 DIAPHRAGM BLADES:

9 MIN FOCUSING DISTANCE: 0.2M MAX
MAGNIFICATION RATIO: 1.0X FILTER SIZE:
67MM DIMENSIONS (L X D): 82 X 73.6MM
WEIGHT: 300G

situations, the lens suffered from a
few contrast issues in the JPEG files,
with out-of-focus areas sometimes
being a little lacklustre and drifting
into muted grey. However, if you're
shooting in raw format this will be
less of a concern, as Panasonic’'s raw
files are excellent.

Focusing was good and shappy
when shooting at a distance, with the
new Dual-Phase Linear Motor being
near silent in operation. The Lumix S
100mm combined with a Lumix S5 11X
body had no issue locking onto and
tracking subjects across the frame
during stills shooting and also in
video. Panasonic has claimed the new
lens motor is faster than its previous
incarnation - although | didn't notice
any dramatic difference in speed
when driving focus from near to far
than with other Panasonic lenses.

However, there were occasional
struggles when it came to close
focusing, with the lens sometimes
hunting for focus when used close
up to a subject before eventually
locking on. This was occasional,
but unfortunately happened more
frequently than | found ideal,
although I'm not sure how much
responsibility to assign to the camera
and how much to the lens - and this
is something that could be improved
with firmware down the line.

Panasonic's implementation of in-
body image stabilisation is absolutely
rock solid - though it's unsurprising
when you remember that Panasonic
invented IBIS - and the Lumix S 100
on a camera with IBIS like my S5 11X
should offer up to seven stops of
correction. In reality, it does - shooting
in low light with the Lumix S 100mm
| was able to stop down to around
1/15 sec handheld and still get
plenty of usable shots, although your
experience might vary depending on
how steady your hands are.

However, there's no optical image
stabilisation in the lens, which is
likely a sacrifice made in order to
get it down to such a compact size,
but | can't help wondering whether
a hybrid stabilisation system could
have achieved even greater heights
of handheld steadiness.

Gareth Bevan

SHARPNESS
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Sharpness isn't as impressive as we'd hoped for.
Centre sharpness is poor at larger apertures,
and you only get the best out of the lens at f/8.
However, it's worth noting that we tested an
early production sample lens, so it's possible
that retail models will perform better.

FRINGING

Colour fringing is very well controlled, and of
a low order across the entire image frame.

DISTORTION

The lens produces moderate pincushion
distortion, though this is without any in-camera
distortion correction applied.

VERDICT

For a full-frame macro lens, the
compactness and lightness
Panasonic have achieved with
the Lumix S 100mm f/2.8 Macro
are genuinely remarkable. The
downside is that there are a few
compromises in performance. At the
near end the lens hunted for focus
more than I'd have liked; it could
also be a bit sharper throughout
the frame, and JPEGs lack contrast,
so if you're a Panasonic shooter
waiting for a Lumix S macro lens
this isn't quite a flawless entry:.
It's nonetheless a very good
compact macro lens that's worth
adding to your collection, but you
might still look at rival systems with
a pang of jealousy.
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inspection. See unique images of each unique
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